
Example Test Sets
The following table is a summary of the example datasets provided in the TESTSET sub-
directory.

Name Column
s

Row
s

Description

LOGIC 5 4 Contains a truth table for 2 input logical AND, OR and
XOR operations.

ENCODE 11 8 Contains a truth table for an 8 input to 3 output 
binary encoder. If the inputs and outputs are 
reversed then the table becomes a 3 to 8 decoder.

AIR 13 108 Contains a table of number of airplane tickets sold by
month for 9 years. The table is arranged 13 months 
wide with the first 12 months being the previous 12 
months and the NEXT column being the next months 
number of seats. The final 12 rows are reserved for 
testing.

VEL 7 609 Contains the distance traveled by a projectile using 
different angles and initial velocity. Additional 
columns of angle and velocity are included with 
random noise added.

COATING 8 128 Contains the results of a coating experiment. 
Different levels of starch, latex, coating weight, 
bonding agent and calender pressure are visited and 
the effects on opacity, brightness and gloss are 
recorded.

SODIUM 6 220 Contains the results of a designed experiment. 
Different gases and mixtures were tested to see what
combination of gas, time and temperature could be 
used to convert Na2SO4 to Na2S the most yield in 
the shortest time. 

REDWOOD 15 72 Contains the results of a designed experiment. 
Different species of wood chips were tested to see if 
less expensive mixes could be used to make paper 
board while still guaranteeing a minimum strength 
and yield.

RING 15 507 Contains a process log of 14 sensors from a paper 
machine along with one laboratory measurement. 
The purpose of the log is to see if any process 
variables could be used to predict the lab variable.

SPECIES 5 2000 Contains a process log of 4 sensors along with 1 field 
that calculates the wood species exiting a wood 
digestor.

NOX 23 1340 Contains a process log of 23 sensors from a power 
boiler. The purpose of the log was to see if the 
process variables could be used to predict stack 
gases emitting from the boilers smoke stack.

CLO2 6 30 Contains the results of a designed experiment. 
Different levels of chemicals were tested to find the 
ideal setpoints needed to produce ClO2 most 
efficiently. 

CLOSTAT1 9 15 Contains the results of a designed experiment. 
Different stream setpoints were simulated to find the 
most economical setpoints. 



PEAK4 3 121 Contains the results of stepping angles X and Y (11 
steps) from 0 to    and evaluating Z = sin(X) sin(Y)

CURL 9 70 Contains the results of a designed experiment. Paper 
machine variables were varied to discover any major 
effects on paper curl. 

STR4 24 1178 Contains a process log of a paper machine. The 
purpose of the log was to see if the process variables
could be used to best predict strength properties.

To import any of the aforementioned datasets into the NNMODEL issue the Import Data 
From ASCII File command from the File menu. The files are found in the \nnmodel\testsets 
sub-directory. Once a raw file has been imported the data matrix can be saved in binary 
format and reloaded at any time using the Save or Open commands in the File menu.



Example: LOGIC Dataset

LOGIC Detailed Description
File Name - LOGIC.RAW

Description: This dataset contains a truth table of three logical operations (i.e. 
AND, OR and XOR). The experiment is designed to show the results 
of the three separate logical operations given the same inputs. The 
data entered into the table has been translated from the logical 
language into a numerical representation (i.e. 0 = FALSE and 1 = 
TRUE).

Column 
Names

Column Description

IN1 First input into the logical operation
IN2 Second input into the logical operation
AND Logical AND results
OR Logical OR results
XOR Logical XOR results

Data 
Analysis

Analysis is not needed due to the small size of the dataset.

Model 
Building

It is suggested to develop 4 models with this dataset. Build a 
separate model for each of the logical operations and an all 
inclusive model. The 4 models built are:

AND   : IN(IN1, IN2) => OUT(AND)
OR    : IN(IN1, IN2) => OUT(OR)
XOR   : IN(IN1, IN2) => OUT(XOR)
LOGIC : IN(IN1, IN2) => OUT(AND, OR, XOR)

The previous notation reads: Model LOGIC has IN1 and IN2 as inputs
and generates AND, OR and XOR as outputs.
After creating each model select Initialize and Start Training 
commands from the Model menu.

Model 
Analysis

All four models were created and trained using the initial factory 
default settings for the training parameters. After training the 
following model statistics were reported.

Analysis of model AND
Variable Mean        Std Dev Minimum Maximu

m 
Sum Sq

IN1           
0.50000
0

 
0.57735
0 

 
0.00000
0 

 
1.00000
0 

 
1.00000
0

IN2           
0.50000
0 

 
0.57735
0 

 
0.00000
0 

 
1.00000
0 

 
1.00000
0 

      
Measured

 
0.25000
0 

 
0.50000
0 

 
0.00000
0 

 
1.00000
0 

 
0.75000
0 

      
Predicted

 
0.23293
0 

 
0.49859
5 

-
0.12671
2 

 
0.97078
7 

 
0.74579
1 

      Residual   -   



0.01707
0 

0.08180
8 

0.05952
0 

0.12671
2 

0.02007
8 

      R Square  0.973230 

Analysis of model OR
Variable Mean        Std Dev Minimum Maximu

m 
Sum Sq

IN1           
0.50000
0 

 
0.57735
0 

 
0.00000
0 

 
1.00000
0 

 
1.00000
0 

IN2           
0.50000
0 

 
0.57735
0 

 
0.00000
0 

 
1.00000
0 

 
1.00000
0 

      
Measured

 
0.75000
0 

 
0.50000
0 

 
0.00000
0 

 
1.00000
0 

 
0.75000
0 

      
Predicted

 
0.75437
2 

 
0.49165
4 

 
0.01941
8 

 
1.05648
9 

 
0.72517
0 

      Residual -
0.00437
2 

 
0.04188
4 

-
0.05648
9 

 
0.03490
0 

 
0.00526
3 

      R Square  0.992983 

Analysis of model XOR
Variable Mean        Std Dev Minimum Maximu

m 
Sum Sq

IN1           
0.50000
0 

 
0.57735
0 

 
0.00000
0 

 
1.00000
0 

 
1.00000
0 

IN2           
0.50000
0 

 
0.57735
0 

 
0.00000
0 

 
1.00000
0 

 
1.00000
0 

      
Measured

 
0.50000
0 

 
0.57735
0 

 
0.00000
0 

 
1.00000
0 

 
1.00000
0 

      
Predicted

 
0.50070
8 

 
0.57455
4 

-
0.00112
6 

 
0.99909
0 

 
0.99033
7 

      Residual -
0.00070
8 

 
0.00452
2 

-
0.00740
5 

 
0.00253
5 

 
0.00006
1 

      R Square  0.999939 

Analysis of model LOGIC
Variable Mean        Std Dev Minimum Maximu

m 
Sum Sq

IN1           
0.50000
0 

 
0.57735
0 

 
0.00000
0 

 
1.00000
0 

 
1.00000
0 

IN2           
0.50000
0 

 
0.57735
0 

 
0.00000
0 

 
1.00000
0 

 
1.00000
0 

AND
           



Measured 0.25000
0 

0.50000
0 

0.00000
0 

1.00000
0 

0.75000
0 

      
Predicted

 
0.21522
9 

 
0.51705
0 

-
0.19736
4 

 
0.96998
9 

 
0.80202
3 

      Residual  
0.03477
1 

 
0.11903
0 

-
0.08651
0 

 
0.19736
4 

 
0.04250
4 

      R Square  0.943328 
OR
      
Measured

 
0.75000
0 

 
0.50000
0 

 
0.00000
0 

 
1.00000
0 

 
0.75000
0 

      
Predicted

 
0.83017
9 

 
0.53260
6 

 
0.07566
5 

 
1.32254
7 

 
0.85100
8 

      Residual -
0.08017
9 

 
0.17509
9 

-
0.32254
7 

 
0.08839
3 

 
0.09197
9 

      R Square  0.877361 
XOR
      
Measured

 
0.50000
0 

 
0.57735
0 

 
0.00000
0 

 
1.00000
0 

 
1.00000
0 

      
Predicted

 
0.50292
1 

 
0.33972
7 

 
0.24758
0 

 
1.00162
8 

 
0.34624
4 

      Residual -
0.00292
1 

 
0.47116
5 

-
0.41813
3 

 
0.65565
9 

 
0.66598
9 

      R Square  0.334011 

After reviewing the above model statistics it was noted that the first 
three separate models predicted the output very well. However, the 
results of the LOGIC model showed a significant loss of accuracy (as 
measured by R Square) when combining the three logic functions. 
The all inclusive model cannot predict as well as the separate 
models because the default training parameters did not allow the 
model to build up enough internal complexity. The following table 
demonstrates that selecting any type of training that will raise the 
internal complexity will also result in better models. The highlighted 
model was the initial factory default parameters model shown 
above.

Training
Type

Coun
t

Options AND OR XOR

AI 1000 0.94332
8

0.87736
1

0.33401
1

Standard 4 
Hid

1000 0.89476
8

0.99953
0

0.99999
6

AI 1000 Connect 
I/O

0.99174
3

0.99646
3

0.99354
5 

AI 5000 1.00000
0

1.00000
0

1.00000
0 



Standard 4 
Hid

1000 CG Train 0.99999
6

0.99999
9

0.99999
7 

Equal Spaced 1000 0.99999
7 

0.99999
9

1.00000
0



Example: ENCODE Dataset

ENCODE Detailed Description
File Name - ENCODE.RAW

Description: This dataset contains a truth table of three logical operations (i.e. 
AND, OR and XOR). The experiment is designed to show the results 
of the three separate logical operations given the same inputs. The 
data entered into the table has been translated from the logical 
language into a numerical representation (i.e. 0 = FALSE and 1 = 
TRUE).

Column 
Names

Column Description

IN1 Input 1 to encoder or output from decoder
IN2 Input 2 to encoder or output from decoder
IN3 Input 3 to encoder or output from decoder
IN4 Input 4 to encoder or output from decoder
IN5 Input 5 to encoder or output from decoder
IN6 Input 6 to encoder or output from decoder
IN7 Input 7 to encoder or output from decoder
IN8 Input 8 to encoder or output from decoder
OUT1 Output 1 from encoder or input to decoder
OUT2 Output 2 from encoder or input to decoder
OUT3 Output 3 from encoder or input to decoder

Data 
Analysis

The following truth table was used as the dataset.

Encoder/Decoder Truth Table
IN1 IN2 IN3 IN4 IN5 IN6 IN7 IN8 OUT1 OUT2 OUT3
0.0 0.0 0.0 0.0 0.0 0.0 0.0 1.0 0.0 0.0 0.0
0.0 0.0 0.0 0.0 0.0 0.0 1.0 0.0 0.0 0.0 1.0
0.0 0.0 0.0 0.0 0.0 1.0 0.0 0.0 0.0 1.0 0.0
0.0 0.0 0.0 0.0 1.0 0.0 0.0 0.0 0.0 1.0 1.0
0.0 0.0 0.0 1.0 0.0 0.0 0.0 0.0 1.0 0.0 0.0
0.0 0.0 1.0 0.0 0.0 0.0 0.0 0.0 1.0 0.0 1.0
0.0 1.0 0.0 0.0 0.0 0.0 0.0 0.0 1.0 1.0 0.0
1.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 1.0 1.0 1.0

Model 
Building

It is suggested to develop 2 models from this dataset. Build a 
encoder model (ENCODE) using IN1 through IN8 as inputs and OUT1
- OUT3 as outputs and build a decoder model (DECODE) using 
OUT1-OUT3 as inputs and IN1-IN8 as outputs. The 2 models built 
are:

ENCODE   : IN(IN1,...,IN8)   => OUT(OUT1,...,OUT3)
DECODE   : IN(OUT1,...,OUT3) => OUT(IN1,...,IN8)

Model 
Analysis

Both models were created and trained using the initial factory 
default settings plus Standard BEP for the training parameters. 
After training the following model statistics were reported:

Model ENCODE
Predicted R Square



Outputs
OUT1  1.000000 
OUT2  1.000000 
OUT3  1.000000 

Model DECODE
Predicted
Outputs

R Square

IN1  0.903213 
IN2  0.903793 
IN3  0.903345 
IN4  0.903565 
IN5  0.903188 
IN6  0.903522 
IN7  0.904014 
IN8  0.905515 

With digital type functions it is hard to get a picture of how well 
these models are doing. The best way with these particular models 
is to interactively test them. This can be done using the 
Interrogate Model command in the Model menu.



Example: AIR Dataset

AIR Detailed Description
File Name - AIR.RAW

Description: This dataset was constructed to demonstrate how a neural model 
can be used to predict a time series. It contains 12 columns of the 
number of tickets sold during the previous twelve months followed 
by the number of tickets sold during the next month. The dataset 
was generated from the following table titled Airline Ticket Sales 
1980-1989 by re-arraigning the first 9 rows for use as a training 
matrix and the last row as a test matrix. 

Airline Ticket Sales 1980-1989
Jan Feb Mar Apr May Jun Jul Aug Sep Oct Nov Dec

1980 145 153 171 167 157 179 190 192 178 153 133 151
1981 155 163 183 172 162 194 221 220 204 172 144 182
1982 188 197 231 212 224 231 256 263 242 211 190 218
1983 224 234 253 235 237 286 300 313 275 249 223 253
1984 254 257 309 306 295 315 345 356 308 271 235 261
1985 267 243 303 295 304 344 394 375 338 295 261 299
1986 319 304 342 350 355 410 473 452 402 360 309 365
1987 367 362 413 408 416 487 537 527 460 397 347 399
1988 411 393 464 455 461 546 604 608 523 452 399 438
1989 439 413 468 449 473 565 641 656 527 469 401 439

The following table demonstrates how the previous table was rearranged to be used as a 
training matrix.

Re-arraigned Ticket Sales
M1 M2 m3 M4 M5 M6 M7 M8 M9 M10 M11 M12 NEXT
145 153 171 167 157 179 190 192 178 153 133 151 155
153 171 167 157 179 190 192 178 153 133 151 155 163
171 167 157 179 190 192 178 153 133 151 155 163 183
167 157 179 190 192 178 153 133 151 155 163 183 172

and so on...

Column 
Names

Column Description

M1 The number of tickets sold twelve months ago
M2 The number of tickets sold eleven months ago
M3 The number of tickets sold ten months ago
M4 The number of tickets sold nine months ago
M5 The number of tickets sold eight months ago
M6 The number of tickets sold seven months ago
M7 The number of tickets sold six months ago
M8 The number of tickets sold five months ago
M9 The number of tickets sold four months ago
M10 The number of tickets sold three months ago
M11 The number of tickets sold two months ago
M12 The number of tickets sold last month
NEXT The number of tickets that will be sold this month

Data 
Analysis

A By Row Matrix graph was printed to see the monthly trend and 
verify that there were no gross errors in the dataset.

Model One model was constructed from this dataset:



Building AIR   : IN(M1,M2,...,M12) => OUT(NEXT)

Model 
Analysis

The model was created and trained using the initial factory default 
settings for the training parameters. After training the following 
model statistics were reported.

Variable Mean        Std Dev Minimum Maximu
m 

Sum Sq

M1            277.885
41 

93.69096
9 

133.000
00 

537.000
00 

833909.
78 

M2            280.656
24 

93.65298
3 

133.000
00 

537.000
00 

833233.
70 

M3            283.156
24 

93.41242
5 

133.000
00 

537.000
00 

828958.
70 

M4            286.208
33 

94.48975
9 

133.000
00 

537.000
00 

848189.
88 

M5            289.208
33 

95.23411
0 

133.000
00 

537.000
00 

861605.
89 

M6            292.374
99 

95.84398
3 

133.000
00 

537.000
00 

872676.
56 

M7            296.197
91 

98.55510
3 

133.000
00 

546.000
00 

922745.
29 

M8            300.510
41 

102.8245
3 

133.000
00 

604.000
00 

1004423
.9 

M9            304.843
75 

106.8888
5 

133.000
00 

608.000
00 

1085396
.5 

M10          308.437
50 

108.3687
4 

133.000
00 

608.000
00 

1115659
.5 

M11          311.552
08 

108.1508
5 

133.000
00 

608.000
00 

1111177
.6 

M12          314.322
92 

106.9287
5 

144.000
00 

608.000
00 

1086207
.0 

NEXT
      
Measured

317.312
50 

106.3247
5 

144.000
00 

608.000
00 

1073970
.6 

      
Predicted

319.780
79 

105.5086
1 

171.214
96 

591.722
90 

1057546
.5 

      Residual -
2.46828
5 

16.03191
5 

-
51.8956
9 

34.4275
51 

24417.1
17 

      R Square  0.977265 

To see how the model predicts the next twelve months select Use 
Test Matrix from the Model menu and re-run the model statistics.

Variable Mean        Std Dev Minimum Maximu
m 

Sum Sq

NEXT
      
Measured

495.000
01 

84.7445
27 

401.000
00 

656.000
00 

78997.9
84 

      
Predicted

524.930
71 

65.0817
95 

446.558
16 

628.020
99 

46592.0
40 

      Residual -
29.9307

26.5575
98 

-
59.2269

27.9790
04 

7758.36
62 



0 2 
      R Square  0.901790 

As you can see, the worst case under prediction was around 59 and 
the worst case over prediction was 28 seats. The following plot 
graphically demonstrates the result.

The command used was the Measured and Predicted command 
from the 
Graph menu.



Example: VEL Dataset

VEL Detailed Description
File Name - VEL.RAW

Description: This dataset was constructed to demonstrate how well a neural 
model can predict a trajectory. It contains the distance 
measurement, the angle of launch and the initial velocity. Along 
with the aforementioned columns the dataset also includes the 
aforementioned columns with noise added, plus a column of just 
noise so that you can experiment building neural models with noisy 
signals and compare them with ideal models.

Column 
Names

Column Description

ANGLE Angle measured from horizontal
VEL Initial velocity
RANGLE Angle with Gaussian noise added
RVEL Initial velocity with Gaussian noise added
NOISE Just Gaussian noise
DIST Distance traveled by projectile
RDIST Distance traveled by projectile with Gaussian noise added

Data 
Analysis

A statistics report was generated using the Basic Statistics 
command in the Data menu. This gives us an overall picture of the 
dataset. If correlations are of interest they can be viewed using the 
Correlation Analysis command also in the Data menu.

By viewing the data matrix it can be observed that the initial 
velocity was varied from 0 to 100 by 5 and the launch angle was 
varied from 3 to 87 by 3.

Variable N            Mean        Std Dev Minimum Maximum 
ANGLE      609      45.000000 25.120434  3.000000 87.000000
VEL          609      50.000000 30.301392  0.000000 100.00000
RANGLE    609      45.141823 25.438328 -5.960000 92.910004
RVEL        609      49.991724 30.296755  0.000000 102.98999
NOISE      609      -0.023645  3.387809 -10.18000 11.090000
DIST        609      61.804992 65.890137  0.000000 258.10000
RDIST      609      61.801954 65.948653 -0.040000 262.64001

Model 
Building

Two separate models were constructed from this dataset. The first 
model uses simply the initial velocity and the launch angle:

VEL1   : IN(VEL,ANGLE) => OUT(DIST)
After the previous model was analyzed, and determined to be not 
good enough, a second model was constructed that used 
trigonometric functions as inputs rather than the simple angle:

VEL2   : IN(VEL,SANG,CANG) => OUT(DIST)
Model 
Analysis

The model was created and trained using the initial factory default 
settings for the training parameters plus CG. CG training was added 
because a trajectory is known to be trigonometric in nature and 
harder training is necessary. After training the following model 
statistics were reported.



Variable Mean        Std Dev Minimum Maximu
m 

Sum Sq

ANGLE      45.0000
00 

25.1204
34 

 
3.00000
0 

87.0000
00 

383670.
01 

VEL          49.9999
99 

30.3013
91 

 
0.00000
0 

100.000
00 

558249.
97 

DIST
      
Measured

61.8049
92 

65.8901
37 

 
0.00000
0 

258.099
97 

2639638
.2 

      
Predicted

58.9205
17 

66.3733
02 

-
52.7954
3 

236.051
07 

2678492
.4 

      Residual  
2.88447
5 

15.5243
49 

-
73.2593
3 

52.7954
37 

146531.
29 

      R Square  0.944488 

Although the R Square statistic is respectable, a closer examination 
using the Measured and Predicted or Measured vs. Predicted 
graphs reveal significant problems predicting the distance when the 
angle is near 0 or 90 degrees. The following graph demonstrates the
problem.

Therefore, a second model was created using calculated columns to 
provide more information. Two additional columns were created to 
include the sine and cosine of the launch angle into the model. To 
do this, first add the following two equations to the equation string 
of the data matrix:

SANG = SIN (ANGLE * 2 * PI / 360)
CANG = COS (ANGLE * 2* PI / 360)

Then create the columns using the Append Calculated Columns 
command in the Edit menu. After training the following model 
statistics were reported.

Variable Mean        Std Dev Minimum Maximu
m 

Sum Sq

VEL          49.9999
99 

30.3013
91 

 
0.00000
0 

100.000
00 

558249.
97 

SANG         
0.64118
0 

 
0.29838
6 

 
0.05233
6 

 
0.99863
0 

54.1326
56 



CANG         
0.64118
0 

 
0.29838
6 

 
0.05233
6 

 
0.99863
0 

54.1326
56 

DIST
      
Measured

61.8049
92 

65.8901
37 

 
0.00000
0 

258.099
97 

2639638
.2 

      
Predicted

61.6083
27 

65.6657
10 

-
8.98362
0 

240.978
04 

2621687
.1 

      Residual  
0.19666
5 

 
4.16827
4 

-
10.3147
1 

18.3556
06 

10563.6
98 

      R Square  0.995998 

The R Square statistic is better then the previous model and the 
Measured and Predicted or Measured vs. Predicted graphs 
reveal a significant increase in the overall accuracy.



Example: COATING Dataset

COATING Detailed Description
File Name - COATING.RAW

Description: The coating dataset contains the data from an incomplete designed 
experiment. This experiment was designed to determine the ideal 
levels of the five independent variables (STARCH, LATEX, HP91, 
COATWT and CPSI) necessary to maintain minimum levels of the 
dependent variables (BRIGHTNESS, OPAC and GLOSS). In this 
dataset STARCH, LATEX, HP91 and COATWT are varied to five 
different levels while CPSI is varied to two levels. The independent 
variables STARCH, LATEX, HP91 and CPSI can set to the desired 
target and maintained, however, COATWT cannot controlled as 
accurately. Therefore, the targeted COATWT value is later replaced 
with the measured value.

Column 
Names

Column Description

STARCH The percentage of starch added to the coating.
LATEX The percentage of latex added to the coating. Latex is a rubber 

used as a binding agent in coatings.
HP91 The percentage of HP91 added to the coating. HP91 is a plastic 

pigment.
COATWT The measured amount of coating applied to the paper.
CPSI The pressure applied by a super-calander to polish the surface of 

the coated paper.
BRIGHT The measured brightness of the finished paper/coating. Brightness 

is the measurement of how white the surface of the piece of paper 
is.

OPAC The measured opacity of the finished paper/coating. Opacity is a 
measurement of how opaque (impenetrable to light) a piece of 
paper is.

GLOSS The measured gloss of the finished paper/coating. Gloss is a 
measurement of how polished the surface of a piece of paper looks.

Data 
Analysis

A statistics report was generated using the Basic Statistics 
command in the Data menu. This gives us an overall picture of the 
dataset. If correlations are of interest they can be viewed using the 
Correlation Analysis command also in the Data menu.

Variable N            Mean        Std Dev Minimum Maximum 
STARCH    128      17.928281  5.206710  6.500000 26.000000
LATEX      128      12.720312  3.034249  6.500000 19.500000
HP91        128       5.735938  2.644463  0.000000 11.000000
COATWT    128       4.677344  0.904097  2.960000  6.380000 
CPSI        128      45.500000 19.576621 26.000000 65.000000
BRIGHT    128      65.760938  1.091934 62.900002 68.400002
OPAC        128      70.977344  1.388775 67.699997 74.400002
GLOSS      128      39.965625  7.816129 25.600000 57.500000

Model 
Building

Four models were constructed from this dataset. The first model 
included all dependent variables into one model:

COATING   : IN(STARCH, LATEX, HP91, COATWT, CPSI)



            => OUT(BRIGHT, OPAC, GLOSS)
The next three models were constructed to predict the dependent 
variables separately:

BRIGHT    : IN(STARCH, LATEX, HP91, COATWT, CPSI)
            => OUT(BRIGHT)
OPAC      : IN(STARCH, LATEX, HP91, COATWT, CPSI)
            => OUT(OPAC)
GLOSS     : IN(STARCH, LATEX, HP91, COATWT, CPSI)
            => OUT(GLOSS)

Model 
Analysis

The first model (COATING) was created and trained using the initial 
factory default settings for the training parameters plus Standard 
BEP. After training the following model statistics were reported.

Variable Mean        Std Dev Minimum Maximu
m 

Sum Sq

STARCH    17.9282
81 

 
5.20671
0 

 
6.50000
0 

26.0000
00 

3442.94
79 

LATEX      12.7203
12 

 
3.03424
9 

 
6.50000
0 

19.5000
00 

1169.24
70 

HP91         
5.73593
8 

 
2.64446
4 

 
0.00000
0 

11.0000
01 

888.134
80 

COATWT     
4.67734
4 

 
0.90409
7 

 
2.96000
0 

 
6.38000
0 

103.808
70 

CPSI        45.5000
00 

19.5766
21 

26.0000
00 

65.0000
00 

48672.0
00 

BRIGHT
      
Measured

65.7609
38 

 
1.09193
4 

62.9000
02 

68.4000
02 

151.424
73 

      
Predicted

65.9070
51 

 
1.09308
3 

63.2971
92 

68.3630
07 

151.743
55 

      Residual -
0.14611
3 

 
0.36833
7 

-
1.58667
8 

 
0.66027
1 

17.2303
82 

      R Square  0.886212 
OPAC
      
Measured

70.9773
44 

 
1.38877
5 

67.6999
97 

74.4000
02 

244.944
35 

      
Predicted

70.8909
38 

 
1.28765
6 

67.9260
71 

74.0463
33 

210.573
38 

      Residual  
0.08640
6 

 
0.49188
4 

-
1.03631
6 

 
2.01051
3 

30.7275
83 

      R Square  0.874553 
GLOSS
      
Measured

39.9656
25 

 
7.81612

25.6000
00 

57.5000
00 

7758.66
86 



9 
      
Predicted

39.9837
50 

 
7.33267
0 

25.6559
18 

58.5900
76 

6828.54
21 

      Residual -
0.01812
5 

 
2.20028
0 

-
6.19895
9 

 
5.02102
3 

614.836
27 

      R Square  0.920755 

The next three models (BRIGHT, OPAC and GLOSS) were trained 
using the same training parameters as the first model. This shows 
that modeling the dependent variables separately can produce 
higher R Square models under identical conditions. 

BRIGHT
      
Measured

65.7609
38 

 
1.09193
4 

62.9000
02 

68.4000
02 

151.424
73 

      
Predicted

65.8772
90 

 
1.11831
2 

63.1876
56 

68.5457
23 

158.828
89 

      Residual -
0.11635
2 

 
0.32166
7 

-
1.40486
1 

 
0.71015
2 

13.1406
74 

      R Square  0.913220 
OPAC
      
Measured

70.9773
44 

 
1.38877
5 

67.6999
97 

74.4000
02 

244.944
35 

      
Predicted

71.0150
69 

 
1.30649
0 

68.1092
15 

74.4721
68 

216.778
25 

      Residual -
0.03772
5 

 
0.45061
9 

-
1.25515
0 

 
1.76705
2 

25.7882
66 

      R Square  0.894718 
GLOSS
      
Measured

39.9656
25 

 
7.81612
9 

25.6000
00 

57.5000
00 

7758.66
86 

      
Predicted

39.6645
02 

 
7.13537
8 

26.0434
40 

55.8920
56 

6466.02
95 

      Residual  
0.30112
3 

 
2.02177
7 

-
4.90131
8 

 
5.47611
6 

519.123
10 

      R Square  0.933091 

The performance of the first model can be increased by tweaking 
the training parameters. In this case Connect IO and CG Training 
was added to the default settings. After training the following model
statistics were reported.

BRIGHT
      65.7609  62.9000 68.4000 151.424



Measured 38 1.09193
4 

02 02 73 

      
Predicted

65.7603
66 

 
1.04878
9 

63.2032
36 

68.3336
11 

139.694
75 

      Residual  
0.00057
2 

 
0.30598
2 

-
1.24059
3 

 
0.69928
0 

11.8903
49 

      R Square  0.921477 
OPAC
      
Measured

70.9773
44 

 
1.38877
5 

67.6999
97 

74.4000
02 

244.944
35 

      
Predicted

70.9783
19 

 
1.31424
1 

67.8481
98 

74.3544
77 

219.358
00 

      Residual -
0.00097
5 

 
0.43837
1 

-
1.06492
6 

 
1.59545
1 

24.4055
17 

      R Square  0.900363 
GLOSS
      
Measured

39.9656
25 

 
7.81612
9 

25.6000
00 

57.5000
00 

7758.66
86 

      
Predicted

39.9045
86 

 
7.68330
1 

24.7988
70 

58.6896
86 

7497.20
46 

      Residual  
0.06103
9 

 
1.89919
8 

-
4.34608
5 

 
4.68907
5 

458.082
91 

      R Square  0.940959 

The final models were exported to a system optimizer to find the 
answer to: What is the lowest cost coating mixture that can still 
meet the minimum specifications of BRIGHT, OPAC and GLOSS? In 
the optimizer the cost of the coating was calculated by the following
equation: 
   COST = C1COATWT(C2LATEX + C3STARCH + C4HP91)
The solution to the problem would minimize COST while maximizing 
BRIGHT, OPAC and GLOSS and subject to the following constraints: 
BRIGHT > 71.5, OPAC > 78 and GLOSS > 48.

Optimization can not be performed in this version of the program.



Example: SODIUM Dataset

SODIUM Detailed Description
File Names - H2.RAW, CO.RAW, COH2.RAW,MIX.RAW,COH2MIX.RAW

Description: This dataset is really made up of 5 separate datasets. It is the result
of a chemical experiment to determine the best way to reduce 
sodium sulfate to sodium sulfide using hydrogen, carbon monoxide 
or a mixture of both.

The plan was to run each experiment to 160 minutes twice, 
however, the mixture experiment could not be run longer then 70 
minutes due to a problem with the experimental apparatus. The 
data before sixty minutes is not of any use (all the important stuff 
happens from 60 to 160 minutes). Due to this problem the MIX 
experiment yielded only one point per run.

H2 The result of a designed experiment using only hydrogen
gas as the agent and varying temperature and gas 
concentration.

CO The result of a designed experiment using only carbon 
monoxide gas as the agent while varying temperature 
and gas concentration.

COH2 The result of combining both the H2 and CO datasets 
into one using the Concatenate Data Matrices 
command in the Data menu. The combining of these two
datasets is straight forward in that the two experimental 
designs are similar. It involves creating a new field in 
both matrices and setting the missing values to zero.

MIX The result of a designed experiment using a mixture of 
both hydrogen and carbon monoxide gases as the agent 
while varying the gas concentrations and temperatures.

COH2MIX The combined dataset of COH2 and MIX experiments. 
Combining these two datasets is mechanically easy in 
that both matrices have the same fields. However, 
statistically the dataset are very different. COH2 
contains experimental runs where time varies from 60 to
160 and MIX only contains the 60 minute values. It is 
okay to paste these datasets together as long as the 
consequences are understood. The MIX data will serve 
as reference points the model must traverse. The MIX 
data is very important to the model because it contains 
the only points where both gases are present at the 
same time. Other reference points could also be entered 
in this manner (i.e. H2 = 0, CO = 0 and CONV = 0).

Column 
Names

Column Description

TIME Time elapsed since beginning of the run
H2 Percentage of hydrogen gas used
CO Percentage of carbon monoxide gas used
TEMP Temperature during the run
AVTEMP Average temperature of run



CONV Percentage of Na2SO4 converted

Data 
Analysis

H2 and CO contain a central composite design varying 
concentration of the gas and the reaction temperature. Each run 
was replicated twice. The design yielded a total of 10 runs. The MIX 
experiment is a mixture design where the concentrations of H2 and 
CO are varied and the temperature is held constant at the center 
point. The following Basic Statistics reports were generated for all 
the datasets.

H2
Variable N            Mean        Std Dev Minimum Maximum 

TIME        110      110.0000
0 

31.76750
4 

60.00000
0 

160.0000
0 

H2            110      50.00000
0 

22.46301
8 

25.00000
0 

75.00000
0 

TEMP        110      1203.887
7 

18.05452
3 

1179.959
9 

1225.890
0 

AVTEMP    110      1203.779
9 

18.94908
5 

1181.900
0 

1226.199
9 

CONV        110       0.837782  0.089136  0.629880  0.997350

CO
TIME        110      110.0000

0 
31.76750
4 

60.00000
0 

160.0000
0 

CO            110      27.00000
0 

20.24165
9 

 5.000000 50.00000
0 

TEMP        110      1200.516
2 

19.21041
3 

1173.469
9 

1223.449
9 

AVTEMP    110      1199.769
9 

20.42242
2 

1174.699
9 

1221.900
0 

CONV        110       0.665540  0.210730  0.163860  0.979830

COH2
TIME        220      110.0000

0 
31.69489
2 

60.00000
0 

160.0000
0 

CO            220      13.50000
0 

19.67254
8 

 0.000000 50.00000
0 

H2            220      25.00000
0 

29.64785
7 

 0.000000 75.00000
0 

TEMP        220      1202.202
0 

18.67540
6 

1173.469
9 

1225.890
0 

AVTEMP    220      1201.774
9 

19.75697
2 

1174.699
9 

1226.199
9 

CONV        220       0.751661  0.183050  0.163860  0.997350

MIX
TIME        8          60.00000

0 
 0.000000 60.00000

0 
60.00000
0 

CO            8          28.12500
0 

20.86307
4 

 0.000000 50.00000
0 

H2            8          29.68750
0 

28.29807
9 

 0.000000 75.00000
0 

AVTEMP    8          1202.900
0 

 2.988080 1199.300
0 

1206.900
0 



CONV        8           0.599325  0.252241  0.000000  0.758300

COH2MIX.DM
TIME        229      108.0349

3 
32.55331
1 

60.00000
0 

160.0000
0 

CO            229      13.95196
5 

19.82914
7 

 0.000000 50.00000
0 

H2            229      25.49126
6 

29.90122
5 

 0.000000 100.0000
0 

TEMP        229      1202.222
4 

18.31137
8 

1173.469
9 

1225.890
0 

AVTEMP    229      1201.812
2 

19.37154
3 

1174.699
9 

1226.199
9 

CONV        229       0.746724  0.186770  0.000000  0.997350

Model 
Building

Many models were built during the course of the analysis, but only 
the last model is reported. The most complete model was built from 
the COH2MIX dataset.

CONV   : IN(TIME, CO, H2, TEMP)
            => OUT(CONV)

Model 
Analysis

Model (CONV) was created and trained using the initial factory 
default settings for the training parameters    plus Standard BEP 
and CG Optimization .After training the following model statistics 
were reported.

CONV
      
Measured

 
0.74672
4 

 
0.18677
0 

 
0.00000
0 

 
0.99735
0 

 
7.95329
6 

      
Predicted

 
0.74684
7 

 
0.18234
8 

 
0.11648
9 

 
0.99121
2 

 
7.58121
4 

      Residual -
0.00012
3 

 
0.03430
9 

-
0.14795
0 

 
0.07887
2 

 
0.26838
3 

      R Square  0.966255 

A Measured vs. Predicted graph was generated to view how the 
model performed. This graph demonstrates that the model seems to
predict CONV fairly well. The blue lines represent the ± 5% 
tolerance band.



The following contour graph was generated to demonstrate the 
surface of the CONV variable in relation to the concentrations of H2 
and CO, given TEMP=1200 degrees and TIME=110 minutes.



Example: REDWOOD Dataset

REDWOOD Detailed Description
File Name - REDWOOD.RAW

Description: The redwood experiment was done to see if redwood chips could be 
used to replace the less available Douglas fir chips in making wood 
pulp for container board. A designed experiment was done to set 
the various percentages of DFIR, HFIR, PINE, REDW and cooking 
temperatures. A COOK number was included in the dataset for 
identification purposes only. After each batch cook the pulp 
properties TYLD, BPH and KAPN were measured. These pulps were 
refined to three different levels of (REVS) and the pulp property CSF 
was measured. Finally paper was made from the pulp batches and 
the following physical measurements were made on the paper 
TEAR, BURST, FOLD, SCOT and PORS.

Column 
Names

Column Description

COOK The batch number of the cook.
REVS The number of revolutions the pulp was refined to.
DFIR The percentage of Douglas fir chips used in the pulp.
HFIR The percentage of Hemlock fir chips used in the pulp.
PINE The percentage of Pine chips used in the pulp.
REDW The percentage of Redwood chips used in the pulp.
TEMP The temperature the chips were cooked at.
TYLD The percentage of pulp made as a fraction of total chips (pulp test).
BPH The pH of the cook (pulp test).
KAPN The Kappa number (pulp test)
CSF The freeness number. (pulp test).
BURST The result of the burst test (paper test).
FOLD The result of the fold test (paper test).
SCOT The Scott Bond test (paper test).
PORS The porosity measurement (paper test).

Data 
Analysis

A statistics report was generated using the Basic Statistics 
command in the Data menu. This gives us an overall picture of the 
dataset. If correlations are of interest they can be viewed using the 
Correlation Analysis command also in the Data menu.

Variable N            Mean        Std Dev Minimum Maximum 
COOK        72        252.66666  7.253945 241.00000 266.00000
REVS        72        2520.0000 2072.0106  0.000000 5040.0000
DFIR        72         0.267500  0.134675  0.080000  0.430000 
HFIR        72         0.245000  0.088795  0.130000  0.340000 
PINE        72         0.280000  0.068669  0.170000  0.340000 
REDW        72         0.062500  0.057132  0.000000  0.130000 
TEMP        72        447.00000  8.056141 439.00000 455.00000
TYLD        72         0.681931  0.034129  0.603000  0.796000 
TEAR        72        27.023889  4.171943 21.440001 36.639999
BPH          69        15.636232  0.596798 14.300000 16.500000
KAPN        72        79.548611  6.466925 69.099998 96.699997
CSF          72        621.61111 42.098997 536.00000 672.00000
BURST      72         5.463750  1.255601  3.230000  6.900000 



FOLD        72        2464.0694 715.55764 984.00000 4070.0000
SCOT        72         0.169958  0.070813  0.039000  0.299000 
PORS        72         4.729708  2.154128  1.442000  7.824000 

Model 
Building

4 models of unrefined pulp properties were constructed from this 
dataset. The pulp properties modeled are TYLD, BPH and KAPN and 
the only numbers to be included into the model(s) are when the 
REVS is equal to zero (definition of unrefined). To exclude all other 
rows of data except the REVS=0 add to the exclusions string the 
following formula:

XIF (REVS != 0)
The first model included all independent variables (except REVS) of 
the pulp cook into one model predicting the pulp properties:

PULP    : IN(DFIR, HFIR, PINE, REDW, TEMP)
            => OUT(TYLD, BPH, KAPN)

The next three models were constructed to predict the dependent 
variables separately:

TYLD    : IN(DFIR, HFIR, PINE, REDW, TEMP)
            => OUT(TYLD)
BPH     : IN(DFIR, HFIR, PINE, REDW, TEMP)
            => OUT(BPH)
KAPN    : IN(DFIR, HFIR, PINE, REDW, TEMP)
            => OUT(KAPN)

One model of refined pulp properties was created to predict CSF. 
This is the only pulp property (in this experiment) that varies with 
REVS so it is treated separately:

CSF     : IN(DFIR, HFIR, PINE, REDW, TEMP, REVS)
            => OUT(CSF)

Finally a model is constructed to predict all paper properties:
ALL     : IN(DFIR, HFIR, PINE, REDW, TEMP, REVS)
            => OUT(TEAR, BURST, FOLD, SCOT, PORS)

Model 
Analysis

The first model (PULP) was created and trained using the initial 
factory default settings for the training parameters plus Standard 
BEP, CG Training and Connect IO. After training the following 
model statistics were reported.

Variable Mean        Std Dev Minimum Maximu
m 

Sum Sq

DFIR         
0.26217
4 

 
0.13711
2 

 
0.08000
0 

 
0.43000
0 

 
0.41359
1 

HFIR         
0.25000
0 

 
0.08862
6 

 
0.13000
0 

 
0.34000
0 

 
0.17280
0 

PINE         
0.27739
1 

 
0.07001
4 

 
0.17000
0 

 
0.34000
0 

 
0.10784
3 

REDW         
0.06521
7 

 
0.05767
2 

 
0.00000
0 

 
0.13000
0 

 
0.07317
4 

TEMP        446.652
17 

 
8.17206

439.000
00 

455.000
00 

1469.21
73 



3 
TYLD
      
Measured

 
0.68191
3 

 
0.03729
4 

 
0.61700
0 

 
0.79600
0 

 
0.03059
8 

      
Predicted

 
0.68131
5 

 
0.02904
1 

 
0.63433
9 

 
0.76563
0 

 
0.01855
4 

      Residual  
0.00059
8 

 
0.02177
3 

-
0.04140
5 

 
0.04994
0 

 
0.01043
0 

      R Square  0.659141 
BPH
      
Measured

15.6347
83 

 
0.60873
1 

14.3000
00 

16.5000
00 

 
8.15217
1 

      
Predicted

15.6298
08 

 
0.55488
2 

14.6112
90 

16.6051
03 

 
6.77367
0 

      Residual  
0.00497
5 

 
0.26768
4 

-
0.48674
0 

 
0.73599
5 

 
1.57640
4 

      R Square  0.806628 
KAPN
      
Measured

79.9173
91 

 
6.44258
9 

69.1999
97 

96.6999
97 

913.152
91 

      
Predicted

79.9984
69 

 
6.07587
4 

71.6120
45 

92.9928
97 

812.157
43 

      Residual -
0.08107
9 

 
2.00543
5 

-
3.49020
4 

 
3.70710
0 

88.4788
90 

      R Square  0.903106 

After viewing the rather low R Square statistic it was decided to 
create separate models to increase the performance. The following 
three models were trained using the same parameters as the 
previous model.

TYLD
      
Measured

 
0.68262
5 

 
0.03664
0 

 
0.61700
0 

 
0.79600
0 

 
0.03087
8 

      
Predicted

 
0.68276
5 

 
0.03573
1 

 
0.62539
0 

 
0.79726
7 

 
0.02936
4 

      Residual -
0.00014
0 

 
0.00872
2 

-
0.01935
8 

 
0.02158
3 

 
0.00175
0 

      R Square  0.943335 
BPH
      
Measured

15.6347
83 

 
0.60873
1 

14.3000
00 

16.5000
00 

 
8.15217
1 



      
Predicted

15.6339
53 

 
0.54875
7 

14.3714
28 

16.4851
11 

 
6.62494
7 

      Residual  
0.00083
0 

 
0.23642
4 

-
0.52256
0 

 
0.49505
4 

 
1.22972
0 

      R Square  0.849154 
KAPN
      
Measured

79.5500
00 

 
6.55299
4 

69.1999
97 

96.6999
97 

987.659
88 

      
Predicted

79.5358
29 

 
6.38359
5 

69.7009
35 

92.4378
51 

937.256
56 

      Residual  
0.01417
0 

 
1.42162
3 

-
2.36501
3 

 
4.26214
6 

46.4832
97 

      R Square  0.952936 

A single model was constructed to predict CSF. The following model 
was trained using the same parameters as the first model.

CSF
      
Measured

621.611
11 

42.0989
97 

536.000
00 

672.000
00 

125835.
11 

      
Predicted

621.700
89 

41.5371
26 

535.976
07 

670.440
61 

122498.
63 

      Residual -
0.08977
9 

 
6.97516
1 

-
13.0333
8 

21.1813
96 

3454.35
34 

      R Square  0.972549 

A single model was constructed to predict all paper properties. The 
following model was trained using the same parameters as the first 
model.

TEAR
      
Measured

27.0238
89 

 
4.17194
3 

21.4400
01 

36.6399
99 

1235.76
29 

      
Predicted

27.0034
55 

 
3.94627
1 

21.9244
04 

35.2656
40 

1105.68
70 

      Residual  
0.02043
4 

 
1.33341
5 

-
2.84281
2 

 
3.70244
6 

126.237
68 

      R Square  0.897846 
BURST
      
Measured

 
5.46375
0 

 
1.25560
1 

 
3.23000
0 

 
6.90000
1 

111.933
90 

      
Predicted

 
5.46454
9 

 
1.23918
9 

 
3.26577
8 

 
6.73997
6 

109.026
91 

      Residual -  -   



0.00079
9 

0.19520
9 

0.41406
5 

0.48516
0 

2.70556
3 

      R Square  0.975829 
FOLD
      
Measured

2464.06
94 

715.557
65 

984.000
06 

4070.00
00 

3635361
5. 

      
Predicted

2464.03
29 

639.976
92 

1189.07
34 

3518.63
54 

2907950
3. 

      Residual  
0.03649
1 

323.195
81 

-
498.263
4 

998.629
63 

7416343
.1 

      R Square  0.795994 
SCOT
      
Measured

 
0.16995
8 

 
0.07081
3 

 
0.03900
0 

 
0.29900
0 

 
0.35603
1 

      
Predicted

 
0.17015
0 

 
0.06693
4 

 
0.05059
5 

 
0.26006
5 

 
0.31808
7 

      Residual -
0.00019
2 

 
0.02307
1 

-
0.05977
3 

 
0.05357
2 

 
0.03779
2 

      R Square  0.893851 
PORS
      
Measured

 
4.72970
8 

 
2.15412
8 

 
1.44200
0 

 
7.82400
0 

329.459
02 

      
Predicted

 
4.72476
8 

 
2.13945
7 

 
1.53914
0 

 
7.43190
2 

324.986
66 

      Residual  
0.00494
0 

 
0.24248
7 

-
0.49511
5 

 
0.50062
3 

 
4.17479
5 

      R Square  0.987328 

The final question. What mixture of wood chips, cooking 
temperature and REVS would allow us the meet the minimum paper
properties while minimizing DFIR and maximizing TYLD?

subject to the following constraints:
FOLD > 2500
SCOT > 0.14
REDW > 0.10
DFIR+HFIR+PINE+REDW < 1.0

Optimization can not be performed in this version of the program.

Example: RING Dataset

RING Detailed Description
File Name - RING.RAW

Description: The RING dataset was captured during the normal operation of a 
paper machine. The intent of the data capture was to see if any of 
the standard logged process variables could be used to predict a 



physical property (MDRING) of the manufactured paper board. This 
experiment is really a fishing expedition in that no designed 
experiment was performed on the process variables. However, there
may be enough information in the log to point to variables that have
a major effect.

Column 
Names

Column Description

MDRING Ring crush measured in machine direction
CONDWT Basis weight measurement
AVEMO Average moisture of the paper board measurement
SPEED Machine speed measurement
FL1 Flow rate measurement
CS1 Consistancy measurement
FL2 Flow rate measurement
FL3 Flow rate measurement
FL4 Flow rate measurement
HP1 Horse power measurement
FL5 Flow rate measurement
FL6 Flow rate measurement
CS2 Consistancy measurement
AN1 Freeness measurement
CS3 Consistancy measurement

Data 
Analysis

A statistics report was generated using the Basic Statistics 
command in the Data menu. This gives us an overall picture of the 
dataset. With this much data it is highly recommended that the data
be viewed using the By Row Matrix command in the graph menu.

Variable N            Mean        Std Dev Minimum Maximum 
MDRING    507      120.27810 15.541973 75.000000 150.00000
CONDWT    507      40.058619  3.296797 32.849998 46.259998
AVEMO      507       6.249132  0.443878  4.250000  7.990000 
SPEED      507      2132.8500 125.89145 1606.0000 2305.0000
FL1 507      21.466075  2.696087 13.000000 26.100000
CS1 507       3.231894  0.412474  2.500000  5.410000 
FL2 507      67.242604 11.245570 35.799999 103.00000
FL3 507      8704.5956 575.66911 6849.0000 9805.0000
FL4 507      51733.443 3700.4051 10000.000 61023.000
HP1 507       1.094359  0.303432  0.500000  2.150000 
FL5 507       0.064083  0.084342  0.000000  0.470000 
FL6 507      42.958383  6.451481 27.700001 58.900002
CS2 507       3.379487  0.317734  3.050000  4.100000 
AN1 507      684.21696 63.229086 500.00000 800.00000
CS3 507       5.599053  0.678285  2.850000  6.730000 

Model 
Building

A model was built that included all independent variables to predict 
the MDRING property:

MDRING    : IN(CONDWT, AVEMO, SPEED,FL1, CS1, FL2,
            FL3, FL4, HP1, FL5, FL6, CS2, AN1,
             CS3 ) => OUT(MDRING)

Model 
Analysis

The model was created and trained using the initial factory default 
settings for the training parameters plus Standard BEP. After 



training the following model statistics were reported.

MDRING
Variable Mean        Std Dev Minimum Maximu

m 
Sum Sq

      
Measured

120.278
10 

15.5419
73 

75.0000
00 

150.000
00 

122225.
78 

      
Predicted

126.972
14 

13.3984
55 

78.7609
02 

152.964
43 

90836.4
03 

      Residual -
6.69404
2 

 
9.30849
6 

-
33.8861
2 

28.4812
62 

43843.9
36 

      R Square  0.641287 

A Measured and Predicted graph was generated to view how the 
model performed as a time series. This graph demonstrates that the
model seems to capture much of the variability, but there are major 
gaps.

A Measured vs. Predicted graph was also generated to 
demonstrate the lack of fit.

A sensitivity analysis was run to see which variables account for 
most of the variability of MDRING. The results are presented below.

Sensitivity Analysis of MDRING
Variable Initial Percent
Name        Setting Total

FL1          19.6 +0.1354
3

FL4          47204.5 +0.1255
5

HP1          1.33 +0.1221
8

CS2          3.58 -0.11213



SPEED      1955.5 -0.09160
AVEMO      6.12 -0.08170
FL5          0.24 -0.07192
CS1          3.96 -0.05456
AN1          650.0 +0.0536

1
CONDWT    39.56 +0.0489

4
CS3          4.79 -0.03340
FL6          43.3 +0.0311

6
FL2           69.4 -0.02752
FL3          8327.0 +0.0103

0



Example: SPECIES Dataset

SPECIES Detailed Description
File Name - SPECIES.RAW

Description: The species dataset was downloaded from a process control system 
in a paper mill. It    was the result of an experiment to see if an 
algorithm could be developed that could predict when the wood 
species changed in the output of a continuous wood digestor. A 
continuous digestor converts wood chips into paper pulp. It is like a 
long pipe that you dump chips in a the top and pulp falls out at the 
bottom. The digestor is a hydraulic system that operates under high
pressure and temperature. The inside of a digestor is a very 
corrosive and hence cant be well instrumented. The wood chips 
usually spend 3-5 hours making the trip from the top to the bottom.

Paper is made of a mixture of two species of wood (hardwood and 
softwood). Because the two species cook (digest) so differently they
must be processed and stored separately. The ideal process would 
have two digestors (one for softwood and one for hardwood), 
however due to the expense, many mills have only one. In these 
mills the digestor is swung between the two species. Temperatures, 
chemicals, flows and cooking time vary between the two species. 
Pulp manufactured during this swing is called twilight pulp because 
it is nether hardwood or softwood. The twilight pulp must be treated
as if it was hardwood thus reducing the profitability of the process. If
s detector could be developed that could more exactly determine 
when the crossover was between the species the process would be 
more efficient.

The species dataset represents a 33 hour period. Each row is a one 
minute scan. Signal A3 was captured by an automatic sampling 
device that bottled the pulp. The A3 sample was then measured in a
laboratory at a later time. The two questions to be answered by this 
experiment are 1) can the species change be detected and 2) what 
signals are the most important?

Column 
Names

Column Description

A1 Blow line gamma process measurement
A2 Refractivity index process measurement
A3 Softwood present calculation (laboratory test)
A4 Triple D calculation (from process measurements)
A5 Consistency process measurement

Data 
Analysis

A statistics report was generated using the Basic Statistics 
command in the Data menu. This gives us an overall picture of the 
dataset. With this much data it is highly recommended that the data
be viewed using the By Row Matrix command in the graph menu.

Variable N            Mean        Std Dev Minimum Maximum 
A1            2000     0.345829  0.125509  0.176045  0.715970 
A2            2000     0.493294  0.166214  0.176530  0.715647 
A3            2000     0.543000  0.498272  0.000000  1.000000 



A4            2000     0.300089  0.150496 -0.074310  0.882878 
A5            2000     0.366992  0.191050  0.136625  0.742250 

Model 
Building

Three models were constructed to predict A3 from the input 
variables:

A3a    : IN(A1, A2, A4, A5) => OUT(A3)
A3b    : IN(A1, A4, A5)     => OUT(A3)
A3c    : IN( A4, A5)        => OUT(A3)

Signal A2 was eliminated from model A3b because it didnt appear to
be significant. Likewise signals A1 and A2 were eliminated from 
model A3c.

Model 
Analysis

The model was created and trained using the initial factory default 
settings for the training parameters. After training the following 
model statistics were reported.

A3
      
Measured

 
0.54300
0 

 
0.49827
2 

 
0.00000
0 

 
1.00000
0 

496.302
00 

      
Predicted

 
0.56994
0 

 
0.47808
1 

-
0.01810
0 

 
1.11042
1 

456.893
43 

      Residual -
0.02694
0 

 
0.03356
6 

-
0.40075
4 

 
0.49968
5 

 
2.25216
6 

      R Square  0.995462 

A Measured and Predicted graph was generated to view how the 
model performed as a time series. This graph demonstrates that the
model seems to predict A3 very well.

A sensitivity analysis was run to see if any of the variables could be 
eliminated from the model. The signal A2 is a candidate for 
elimination.

Sensitivity Analysis of A3
Variable Initial Percent
Name        Setting Total

A4            0.404284 +0.5218
3

A1            0.446008 -0.23331
A5            0.439438 -0.19154
A2            0.446089 +0.0533



2

Another model (without A2) was created to see if the performance is
severely effected. As you can see from the statistics and the 
Measured and Predicted plot the performance actually increased.

A3
      
Measured

 
0.54300
0 

 
0.49827
2 

 
0.00000
0 

 
1.00000
0 

496.302
00 

      
Predicted

 
0.54967
5 

 
0.49686
6 

-
0.05923
4 

 
1.12273
6 

493.505
42 

      Residual -
0.00667
5 

 
0.02561
3 

-
0.40506
1 

 
0.49398
9 

 
1.31143
3 

      R Square  0.997358 

So another sensitivity analysis was done and A1 was eliminated. As 
you can see the model is starting to fall apart but it is still very 
significant. Further attempts at reducing the number of inputs to 
one failed.

A3
      
Measured

 
0.54300
0 

 
0.49827
2 

 
0.00000
0 

 
1.00000
0 

496.302
00 

      
Predicted

 
0.53518
9 

 
0.49916
1 

-
0.07293
9 

 
1.07412
0 

498.075
06 

      Residual  
0.00781
1 

 
0.03422
6 

-
0.53984
3 

 
0.38931
7 

 
2.34161
3 

      R Square  0.995282 





Example: NOX Dataset

NOX Detailed Description
File Name - NOX.RAW

Description: The NOX dataset was captured during the normal operation of a 
power boiler. The intent of the data capture was to see if any of the 
standard logged process variables could be used to predict the four 
stack gas variables. This experiment is really a fishing expedition in 
that no designed experiment was performed on the process 
variables. However, there may be enough information in the log to 
point to variables that have a major effect.

Column 
Names

Column Description

AMBAIR Ambient air temperature.
BARKFEED Amount of bark fed into the boiler.
BARKOFP Air pressure over bark bed.
BARKUAIR Air pressure under bark bed.
COALUPL Amount of coal fed to upper level.
COALMILV Amount of coal fed to middle level.
COALLOLV Amount of coal fed to lower level.
1LVATEMP Level 1 flame/gas temperature.
2LVATEMP Level 2 flame/gas temperature.
3LVATEMP Level 3 flame/gas temperature.
GASBURN Amount of natural gas fed into boiler (main burners).
GASIGN Amount of natural gas fed into boiler (ignitor).
OILUPLV Amount of fuel oil upper level.
OILMILV Amount of fuel oil lower level.
PAIRUPLV Primary air feed upper level.
PAIRMILV Primary air feed middle level.
PAIRLOLV Primary air feed lower level.
SECUPLV Secondary air feed upper level.
SECMILV Secondary air feed middle level.
SECLOLV Secondary air feed lower level.
STEAMPR Output steam pressure.
STEAMFLO Output steam flow.
STEAMTMP Output steam temperature.
NOX Nitrogen oxides exhaust from stack.
O2 Free oxygen exhaust from stack.
SO2 Sulfur dioxide exhaust from stack.
OPAC Opacity of exhaust gases from stack.

Data 
Analysis

A statistics report was generated using the Basic Statistics 
command in the Data menu. This gives us an overall picture of the 
dataset. With this much data it is highly recommended that the data
be viewed using the By Row Matrix command in the graph menu.
If you look closely at the NOX, SO2 and OPAC you will see a re-
occurring blip. This was traced to a particular maintenance item 
done once a day. 

Variable N            Mean        Std Dev Minimum Maximum 
AMBAIR    1340    104.44056 10.743963 85.480003 128.58999
BARKFEED 1340    84.214254 10.266984 51.849998 103.26000
BARKOFP 1340    25.602993  2.868492 -0.030000 26.530001



BARKUAIR 1340    410.85285 54.698823 27.520000 477.77999
COALUPL 1340     0.840000  2.806041  0.000000 15.620000
COALMILV 1340     0.294045  1.433840 -0.070000 10.690000
COALLOLV 1340     0.278000  1.336544  0.010000 14.230000
1LVATEMP 1340    169.54458 27.795764 100.05000 233.13000
2LVATEMP 1340    137.48353 39.120769 85.930000 227.55999
3LVATEMP 1340    113.24388 31.235535 75.570000 238.50999
GASBURN 1340    16.029052 32.871236 -0.020000 155.42999
GASIGN    1340     7.511463  2.763247 -0.040000 14.110000
OILUPLV 1340     0.602015  3.001349 -0.040000 21.070000
OILMILV 1340     0.979067  4.984428 -0.060000 32.340000
PAIRUPLV 1340    26.027418  6.590400  8.530000 35.990002
PAIRMILV 1340    13.760216 10.276768  3.860000 33.669998
PAIRLOLV 1340     9.025209  6.088600  6.140000 31.410000
SECUPLV 1340    81.394933 18.186028 54.389999 160.39999
SECMILV 1340    94.725522 20.819705 70.080002 172.58999
SECLOLV 1340    100.07086 15.736587 74.120003 137.91000
STEAMPR 1340    1638.9450 24.963765 1519.9499 1715.2800
STEAMFLO 1340    489.19210 95.430005 115.61000 694.27002
STEAMTMP 1340    1201.7549  8.199598 1130.4699 1226.1199
NOX          1340    91.407224 27.824783 32.880001 240.52000
O2            1340     9.999037  2.547359  2.930000 23.280001
SO2          1340    32.512619 39.967415 14.300000 370.76001
OPAC        1340     4.133246  1.442123  2.370000 19.900000

Model 
Building

Due to the large amount of data in this dataset, 80% of it was 
reserved for testing. The first model was constructed to predict NOX
from all input variables:

NOX1    : IN(AMBAIR, BARKFEED, BARKOFP, BARKUAIR,
            COALUPL, COALMILV, COALLOLV, 1LVATEMP,
            2LVATEMP, 3LVATEMP, GASBURN, GASIGN,
            OILUPLV, OILMILV, PAIRUPLV, PAIRMILV,
            PAIRLOLV, SECUPLV, SECMILV, SECLOLV,
            STEAMPR, STEAMFLO, STEAMTMP)
         => OUT(NOX)

Model 
Analysis

The first model (NOX1) was created and trained using the initial 
factory default settings for the training parameters. After training 
the following model statistics were reported.

NOX1 - Training matrix statistics based on 146 observations.
      
Measured

93.8384
93 

27.5362
46 

38.1699
98 

181.630
00 

109945.
50 

      
Predicted

92.6750
19 

26.0586
15 

46.3746
72 

171.664
12 

98462.4
53 

      Residual  
1.16347
4 

 
9.15650
8 

-
20.9850
2 

45.1714
71 

12157.0
38 

      R Square  0.889427 

The model was tested using the test matrix and the following model
statistics were reported.

NOX1 - Test matrix statistics based on 1194 observations.



      
Measured

91.1099
33 

27.8567
27 

32.8799
97 

240.520
02 

925764.
67 

      
Predicted

90.0279
41 

25.1873
65 

50.6704
48 

173.303
37 

756843.
17 

      Residual  
1.08199
2 

10.1323
22 

-
54.0867
3 

70.0591
13 

122478.
08 

      R Square  0.867701 

The model performance did not collapse on the test matrix 
indicating that the model is probably OK. The next step is to run a 
sensitivity analysis on the model to see if any input variables could 
be removed. The following table was generated using the 
Sensitivity Report command in the Model menu.

Sensitivity Analysis of NOX
Variable Initial Percent
Name        Setting Total

COALUPL  7.81 +0.1580
3

COALLOLV  7.12 +0.1500
3

BARKOFP  13.25 -0.12880
1LVATEMP 166.59 +0.0892

9
AMBAIR    107.04 -0.07536
3LVATEMP 157.04 +0.0589

2
COALMILV     5.31 +0.0577

8
STEAMFLO 404.94 +0.0486

4
OILMILV  16.14 -0.04636
OILUPLV  10.52 +0.0367

7
2LVATEMP 156.75 -0.03403
PAIRLOLV 18.78 +0.0244

3
STEAMTMP 1178.30 +0.0207

8
SECMILV 121.34 -0.01325
GASIGN        7.04 -0.01165
PAIRMILV 18.77 -0.01096
SECLOLV 106.02 +0.0098

2
SECUPLV 107.40 -0.00617
BARKUAIR 252.65 +0.0061

7
PAIRUPLV 22.26 -0.00480
BARKFEED  77.56 +0.0034

3
GASBURN     77.71 -0.00297
STEAMPR 1617.61 -0.00160

After reviewing the previous report, it was decided that variables 



that had less then a 2% effect on NOX should be eliminated. The 
following variables were eliminated: SECMILV, GASIGN ,PAIRMILV, 
SECLOLV, SECUPLV, BARKUAIR, PAIRUPLV, BARKFEED, GASBURN and
STEAMPR. A new model (NOX2) was then created and trained using 
the paired down input list.

NOX2 - Training matrix statistics based on 146 observations.
      
Measured

93.8384
93 

27.5362
46 

38.1699
98 

181.630
00 

109945.
50 

      
Predicted

92.2616
39 

26.2547
64 

41.6774
37 

174.910
64 

99950.3
33 

      Residual  
1.57685
5 

 
9.13264
3 

-
22.1242
2 

43.5268
02 

12093.7
50 

      R Square  0.890002 

The model was tested using the test matrix and the following model
statistics were reported.

NOX2 - Test matrix statistics based on 1194 observations.
      
Measured

91.1099
33 

27.8567
27 

32.8799
97 

240.520
02 

925764.
67 

      
Predicted

89.7466
92 

25.1003
64 

46.3053
05 

178.312
56 

751623.
71 

      Residual  
1.36324
1 

10.5586
78 

-
51.7345
0 

65.6222
84 

133002.
42 

      R Square  0.856332 



Example: CLO2 Dataset

CLO2 Detailed Description
File Name - CLO2.RAW

Description: The CLO2 dataset was the result of an chemical experiment to find 
the best operating points for ACID, TEMP, H2O2 and NaClO3 to 
product ClO2.

Column 
Names

Column Description

ACID        Amount of acid used in the reaction
TEMP        The temperature of the reaction
H2O2        Amount of hydrogen peroxide used in the reaction
NACLO3    Amount of sodium chlorate used in the reaction
CLO2        Amount of chlorine dioxide produced
PROD        Amount of chlorine converted relative to total available

Data 
Analysis

The basic statistics report follows:

Variable N            Mean        Std Dev Minimum Maximum 
ACID        30        12.000000  2.729153  6.000000 18.000000
TEMP        30        60.000000  9.097177 40.000000 80.000000
H2O2        30         1.980333  0.991966  0.140000  4.050000 
NACLO3    30        56.000000 20.943273 20.000000 100.00000
CLO2        30         3.206000  2.199261  0.160000  8.370000 
PROD        30        71.833333 28.118080  3.000000 100.00000

Model 
Building

Build a model of CLO2 and PROD using the other variables as inputs.
Export the models to an optimizer to find the maximum production.



Example: CLOSTAT1 Dataset

CLOSTAT1 Detailed Description
File Name - CLOSTAT1.RAW

Description: The CLOSTAT1 dataset was the result of an chemical simulation to 
find the best operating points for DIL, CONS and RECY. WAT, D0CS, 
COSW, SOL D1CW and D1CS are process streams resulting from the 
simulation.

Column 
Names

Column Description

DIL          Dilution
CONS        Consistancy
RECY        Recycle water
WAT          
D0CS        
COSW        
SOL          
D1CW        
D1CS        

Data 
Analysis

The basic statistics report follows:

Variable N            Mean        Std Dev Minimum Maximum 
DIL          15         5.000000  0.590399  4.000000  6.000000 
CONS        15         8.794607  3.232301  3.291297 14.284348
RECY        15         0.941179  0.100738  0.778182  1.105573 
WAT          15        7019.7693 1613.4971 5327.4257 11238.688
D0CS        15        767.34628 311.13754 270.94604 1285.0131
COSW        15        313.60096 56.263328 211.49833 405.66909
SOL          15         0.080857  0.019873  0.047394  0.118405 
D1CW        15        204.52833  4.186309 196.89950 211.28370
D1CS        15        808.47947 18.348460 775.10199 838.51586

Model 
Building

Build a models of WAT, D0CS, COSW, SOL, D1CW and D1CS using 
the other variables as inputs. Export the models to an optimizer to 
find ???



Example: PEAK4 Dataset

PEAK4 Detailed Description
File Name - PEAK4.RAW

Description: Contains the results of stepping angles X and Y (11 steps) from 0 to  
and evaluating Z = sin(X) sin(Y)

Column 
Names

Column Description

X The X variable
Y The Y variable
Z The result of the equation

Data 
Analysis

The basic statistics report follows:

Variable N            Mean        Std Dev Minimum Maximum 
X              121       0.500000  0.317543  0.000000  1.000000 
Y              121       0.500000  0.317543  0.000000  1.000000 
Z              121       0.680000  0.200671  0.200000  1.000000 

Model 
Building

Build a model of Z using X and Y as inputs.



Example: CURL Dataset

CURL Detailed Description
File Name - CURL.RAW

Description: The was the result of a designed experiment to find which 
independent variables have the most effect on paper curl. 

Column 
Names

Column Description

JET          Jet to wire ratio measurement
MOIST      Moisture measured on the paper machine
DD            Dryer differential measurement (between top and bottom of the 

sheet)
CDPOS      Position across the paper machine (physical)
FOT          Fiber orientation angle (lab)
SCURL      Simplex curl (lab)
DCURL      Duplex curl (lab)
RCURL      Reel curl (lab)
RMOIST    Reel moisture (lab)

Data 
Analysis

The basic statistics report follows:

Variable N            Mean        Std Dev Minimum Maximum 
JET          70        26.001604 17.569578  6.442120 45.548595
MOIST      70         5.591592  0.587862  4.907064  6.282612 
DD            70        16.901340  8.196261  7.749969 26.027664
CDPOS      70        16.428571 10.965785  1.000000 32.000000
FOT          70         4.145139  9.372166 -18.19136 20.694777
SCURL      70        -1.858674 21.378735 -55.25967 39.023815
DCURL      70         0.183420 17.469644 -39.00546 26.024122
RCURL      70        -4.502250 11.028441 -25.98776 19.509588
RMOIST    70         6.236317  0.506186  5.269414  6.997371 

Model 
Building

Build models of FOT, SCURL, DCURL and RCURL using JET, MOIST, 
DD and CDPOS as inputs. Try using RMOIST (lab moisture) in place 
of MOIST (on-line measurement).



Example: STR4 Dataset

STR4 Detailed Description
File Name - STR4.RAW

Description: The STR4 dataset was captured during the normal operation of a 
paper machine. The intent of the data capture was to see if any of 
the standard logged process variables could be used to predict 
paper strength properties. This experiment is really a fishing 
expedition in that no designed experiment was performed on the 
process variables. However, there may be enough information in the
log to point to variables that have a major effect.

Column 
Names

Column Description

KSOFT      Percent softwood pulp used in furnish
KHARD      Percent hardwood pulp used in furnish
KBROKE    Percent broke pulp used in furnish
KDEINK    Percent deinked pulp used in furnish
KGRDW      Percent groundwood pulp used in furnish
STARSLD Starch solids
SPEED      Paper machine speed
HDBXPH    Head box pH
HDBXFREE Head box freeness
HDBXCONS Head box consistancy
SOFTCONS Softwood consistancy
SOFTFREE Softwood freeness
HARDCONS Hardwood consistancy
HARDFREE Hardwood freeness
SBSWGT    Supered basis weight
STAF        Supered TAF (strength test)
STEARMD Supered MD tear (strength test)
STEARCD Supered CD tear (strength test)
RAWSTOCK Raw stock basis weight
REELMO    Reel moisture
UBSWGT    Un-supered basis weight
COUCH      Couch vacuum
REELASH Reel ash
LABMO      Lab moisture

Data 
Analysis

The basic statistics report follows:

Variable N            Mean        Std Dev Minimum Maximum 
KSOFT      1178    35.300509  5.127401  0.000000 41.000000
KHARD      1178    11.530560 14.534154  0.000000 47.000000
KBROKE    1178    30.334465  3.890627 10.00000

0 
40.000000

KDEINK    1178     6.057725  4.218549  0.000000 15.000000
KGRDW      1178    16.782683 14.455638  0.000000 34.000000
STARSLD 265       1.216679  0.075545  0.900000  1.600000 
SPEED      1178    2254.4295 100.00711 1845.000

0 
2313.0000

HDBXPH    1178     7.184550  0.133124  6.900000  7.400000 
HDBXFREE 1178    144.56536 73.165909 54.00000 330.00000



0 
HDBXCONS 1178     0.584888  0.044584  0.500000  0.740000 
SOFTCONS 1176     3.716556  0.206896  2.980000  4.300000 
SOFTFREE 1176    501.39881 34.988070 398.0000

0 
635.00000

HARDCON
S

491       3.878411  0.268816  3.360000  4.560000 

HARDFREE 491      417.72301 33.024367 351.0000
0 

483.00000

SBSWGT    642      44.566963  7.246427 36.83000
2 

71.330002

STAF        157      35.529618  6.042086 20.40000
0 

54.430000

STEARMD 340      22.358529  4.784218 14.60000
0 

45.099998

STEARCD 340      26.862941  6.009229 19.40000
0 

56.099998

RAWSTOCK 718      30.471086  4.376988 25.95000
1 

56.759998

REELMO    741       3.851309  0.464810  2.280000  5.420000 
UBSWGT    739      45.397253  6.907419 37.09999

8 
70.580002

COUCH      240       6.915833  1.587740  4.000000 13.900000
REELASH 197      27.450254  2.671402 22.50000

0 
34.500000

LABMO      228       4.524561  0.654777  2.400000  6.200000 

Model 
Building

Build a model of STAF and find the variables that most effect it.

 




